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Outline 

• Jax Rs Tutorial  

 

• Netbeans Example (Hello Rest) 

 

• Netbeans Imported Example 

 

• Netbeans Example – More complex (Book) 
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Useful Firefox 
Addons 
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Useful Firefox Addons 

• In my pc says already installed, in your case it will prompt you 
to install it 

– Restart the firefox too 
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Java API for RESTful Web Services 
 

JAX-RS 
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Recall: what makes up a restful 
web service 

The definition of RESTful web service consists of 
 

1.The base URI for the web service  
• e.g. http://example.com/resources/ 

 

2.The MIME type of the data supported by the web 
service  

• e.g. JSON, XML, YAML 
 

3.The set of operations supported by the web 
service using HTTP methods  

• e.g. POST, GET, PUT, DELETE 
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JAX-WS for RESTful Web Services 

• The Java API for XML Web Services (JAX-WS) provides full 
support for building and deploying RESTful Web services 

 

• Sun article about programming RESTful Web Services with 
JAX-WS: 
http://www.oracle.com/technetwork/articles

/javase/index-137171.html  

 

• But there is another specification JAX-RS 

– Java API for RESTful Web Services 
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JAX-RS 

• JSR 311: http://jcp.org/en/jsr/detail?id=311  
 

• Part of the Java EE 6 platform, JAX-RS fully supports REST 
principles 
 

• Uses annotations to simplify the development of RESTful web 
services 
 

• Allow you to expose simple POJOs as web resources 
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Jersey 

• Sun offers the open source, production quality  

 Reference Implementation for JAX-RS  

 code-named Jersey 

 

 

 

• Jersey also provides an API so that developers may extend 
Jersey to suite their needs 
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The Resource Class (@Path) 

• JAX-RS resource is any POJO that is annotated 
with @Path with relative URI path as value 

• The base URI is the application context 

import javax.ws.rs.Path; 

 

@Path("/stockquote") 

public class StockResource { 

   ....... 

   ...... 

    public String getStockInfo() { 

        return "This is Stock Information"; 

    } 

} 
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Resource Methods 

• Resource methods are public methods of a 

resource class that you identify with a request 

method designator 
• @GET, @PUT, @POST, @DELETE  

• @HEAD, @OPTIONS 
 

• The return values of methods with request 

designator annotations are generally  

• void 

• a Java language type 

• javax.ws.rs.core.Response 
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Example ( http://www.javapassion.com/webservices/jaxrs.pdf ) 

// Assume the application context is  

// http://example.com/catalogue, then 

// 

// GET http://example.com/catalogue/widgets  

// - handled by the getList method 

// GET http://example.com/catalogue/widgets/nnn  

// - handled by the getWidget method. 

 

@Path("widgets") 

public class WidgetsResource { 

 

@GET 

String getList() {...} 

 

@GET @Path("{id}") 

String getWidget(@PathParam("id") String id) 

{...} 
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URI Path Template 

• URI path templates are URIs with variables 

embedded within the URI syntax 

 

 

 

 

 

• The value of the bookmark variable may be 

obtained by adding the @PathParam on method 

parameter 

// Will respond to http://example.com/bookmarks/1234 

@Path("/bookmarks/{bookmark}") 

public class BookmarkResource { 

 

@GET 

public String getBookmark( 

 @PathParam("bookmark") String bookmarkId) { 

... 

} 
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Resource method parameters 

• Resource methods can be annotated with one of the 
following annotations: 

http://www.devx.com/Java/Article/42873/0/page/2  
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Sub Resources 

• Apart from the resource class, it is possible also to annotate 
methods of a resource class with the @Path annotation (sub 
resource methods) 

@Path("/sayHello") 

public class SayHello { 
 

    public SayHello() { 

    } 
 

    @GET 

    @Path("lastname") 

    public String hello() { 

         .............. 

    } 

} 

GET request from the URI 
/sayHello/lastname  

will be handled by the  

hello() sub-resource method 

in the SayHello resource class 
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MIME Types Specification 

• A resource class can produce or consume any type of MIME 
 

• Use @Produces to specify the MIME type for the response  

– a representation that can be produced by a resource 
and sent back to the client 

• Use @Consumes to specify the MIME type for the request  

– a representation of the specific content types that a 
resource can accept from an HTTP request entity 
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Example: MIME specification 

@Path("/sayHello") 

@Produces("application/xml") 

public class SayHelloResource { 
 

 @GET 

 public String getXml() {...} 
 

 @GET 

 @Produces("text/html") 

 public String getHtml() {...} 
 

 @PUT 

 @Consumes("application/xml") 

  public void putXml(String content) {...} 

} 
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Netbeans RestFul Example 

Similar to the Hello Project Example (Netbeans 
import) 
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Netbeans Example >  Create a Web 
Application (1) 

• The first step is to create a web application. Name the web 
application RESTfulLab.  
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Netbeans Example >  (2) Add a 
RESTful service. 

• You should do this by selecting the option to create the 
RESTful web service from pattern.  
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Netbeans Example >  (3) Specify 
the Resource Classes 

 

23/3/2015 21 CS-592 Spring 2015 - Myron Papadakis 
Transformation Systems Laboratory 



Netbeans Example >  (3) Specify 
the Resource Classes 

• Once this is done, keep clicking through the pages of the 
wizard, accepting the defaults on each page. You should wind 
up with a skeleton of a RESTful web service that looks like 
what you see on the next slide 
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Starting to modify the code 

• Change the body of the getXml method to return a “Hello String” 
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Deploying and Testing a Restful 
Web Service 

• Next, do a Clean and Build, and then right-click on the project node and 
select Deploy.  

 

• We are now ready to test the web service.  

– Netbeans can use a browser as a test client for a RESTful service. 
There is a caveat though, only Internet Explorer works correctly to test 
RESTful services.  

 

• You are now read to test the web service. Right-click on the project node, 
and select  

 

• Test RESTful web services  
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Configure REST Test Client 

• When the first Option (Locally Generated Test Client) does 
not work select the second and select the project that you 
just deployed 
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Test Restful Web Services 
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Testing the WS (Alternate) 

• http://localhost:8080/RestFulLab/webresources/student 
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Alternate Testing (Using the Firefox 
Add-on) 

http://localhost:8080/RestFulLab/webresources/student 
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Change the Example (XML to 
HTML) 
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Test the HTML Example 
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Test the HTML Example 

• Immediately by providing the URL of the resource 
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Restful Java Client in Netbeans 
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Creating the Client Project 

• Create a new Java 
Application Project 
“RestFullLabClient” 
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Creating the Client Project 

• File > New > Other > RestFul Client 

23/3/2015 35 CS-592 Spring 2015 - Myron Papadakis 
Transformation Systems Laboratory 



Creating the Client Project 

• Select the Rest Resource > From Project > ResourceLab 
Project > StudentResource  and press Finish 
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Client 

• Something like the following stub will be created 
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Client 

• Take a look at the top of the file 
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Running the client 

• In order to run the client the server must be running… 
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Netbeans Restful Example 2 

Import a Sample Project 
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Example 2: Import Sample Project 
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Test the Sample Project 
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Test the Sample Project > Put a 
value and get back the response 

 1 

2 

3 
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Alternate Testing 

• http://localhost:8080/HelloWorld/resources/greeting 
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Alternate Testing  

• After putting the content we check it by selecting GET again 
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More Complex Example 

Book Example 
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Book Restful Web Service 

• For starters develop a Restful Service that 

– Returns all books 

– Returns a book with a given id 

– Adds a book 

• Obviously we will need a structure for the books (list, map or whatever) 

• Firstly, the Restful Web Service must create a dummy book 

• Each book has 

– Id 

– Name 

– Author 

– Isbn 

– Price 
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Book Restful Web Service 

• Files that we will need to write 

– BookResource.java 

– Book.java 

 

• In this example, we will be using XML as the serialization format, i.e. we 
will send and receive Book entities from the web service using XML. 

 

• The @XMLRootElement annotation on the Book class is a JAXB 
annotation which allows JAXB to convert this entity from Java to XML 
and back. It is possible to annotate the fields and methods within the 
class to customize the serialization, but for our tutorial the JAXB defaults 
are fine. 
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Book.java 
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The resource will thus be hosted at “/bookresource”.  

•Singleton lifecycle ensures that only one instance of this class 
will created by Jersey per web-application.  
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Notes 

• The Consumes and Produces combos can be used to specify the default 
mime type(s) of data which this resource can accept and generate. These 
values can be overridden by individual methods in the class.  

– We will be serializing to XML, so we use the application/xml mime 
type.  

 

• The URL path field specifies the path at which this method can be 
reached, relative to the containing resource. 
In this case we specify {id}, which means this resource method can be 
reached at /bookresource/{id}.  

– The curly braces denote a URI variable.  

– These variables are substituted at runtime in order for a resource to 
respond to a request based on the substituted URI.  
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Notes 

• Since we need the value of the id variable, we use the 
PathParam annotation to map it to the cId parameter.  

• In addBook() case, we’re responding to a POST request and 
expect application/xml input which would be deserialized 
into the book parameter.  

• The book parameter is an Entity parameter (unannotated) 
and is mapped directly from the message body of the 
incoming request. 
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BookResource > Show all Books 

 Set the url and 

press get 
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BookResource > Show Book by id 

• http://localhost:8080/Book/webresources/bookresource/0 

 

The book is returned  
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BookResource > Show Book by id 

• http://localhost:8080/Book/webresources/bookresource/1 

 

There is no book with id 1.. 
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BookResource > Add a book 

• Suppose we want to add a (2nd) book 

• The id is increased according to the size of the structure (map, 
list or whatever we use…) 

• We must make a post request 

• Consider we want to send the following book as a request 

<book> 

<bookAuthor>Leonard Richardson</bookAuthor> 

<bookISBN>ISBN 10: 0596529260 </bookISBN> 

<bookName>RESTful Web Services</bookName> 

</book> 
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BookResource > Add a book > Code 
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XML Post 
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HttpRequester > Post (a book as 
XML) 
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HttpRequester > Post (a book as 
XML) > Verify it is added 
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HttpRequester > Get all books 
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HttpRequester > Delete a book 

• If we want to delete a book what should we do? 

 

• Add a method for deleting a book. 

• Need a parameter for the id of the book 

 

– @DELETE… 

– Go to the map and locate the book id 

– Delete it 
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HttpRequester > Delete a book 

 

http://localhost:8080/Book/webresources/bookresource/0 

 

http://localhost:8080/Book/webresources/bookresource/delete/0 
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HttpRequester > Delete a book 
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HttpRequester > Update a book 

• Need to some code to the resource (@PUT) for updating 

the book  

– Two parameters (bookId,price) 

• http://localhost:8080/Book/webresources/bookresource/u

pdate/0/50 
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Update a book (its price) 
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Rest Example with JAXB + JSON +JQuery 

Similar to Book Example 



JAXB (Just some notes….) 



JAXB Introduction 

• NetBeans 6.5 provides support for web services using JAX-WS 
and JAXB.  

• JAX-WS delegates the mapping of the Java language data 
types to JAXB API. 

– JAXB stands for Java Architecture for XML Binding. 

– JAXB converts XML schemas to Java Content trees and vice 
versa. 

– Java Architecture for XML Binding (JAXB) is a Java 
technology that provides an easy and convenient way to 
map Java classes and XML schema for simplified 
development of Web service  

 



JAXB Introduction 

• Basically JAXB is the translator of XML schemas (and data 
types) to Java and vice versa. 

– Since the WSDL describes the XML schema there is a need 
to translate that schema to Java. 

– It is the job of JAXB to do just that 

 

• JAXB uses annotations to indicate the central elements.  



Overview of Data Binding Using 

JAXB  

 

• Web Service applications need a way to access data that are in XML 
format directly from the Java application.  
 

• Specifically, the XML content needs to be converted to a format that is 
readable by the Java application.  
 

• Data binding describes the conversion of data between its XML and Java 
representations. 
 

• JAX-WS uses Java Architecture for XML Binding (JAXB) to manage all of 
the data binding tasks.  
– Specifically, JAXB binds Java method signatures and WSDL messages 

and operations and allows you to customize the mapping while 
automatically handling the runtime conversion.  

 



Data Binding with JAXB 



JAXB in Bottom-up (and Top-down) 

• Start from Java: Using this programming model, you create 
the Java classes.  

– At run-time, JAXB marshals the Java objects to generate 
the XML content which is then packaged in a SOAP 
message and sent as a Web Service request or response.  

 

• Start from WSDL: Using this programming model, the XML 
Schemas exist and JAXB unmarshals the XML document to 
generate the Java objects.  



JAXB Architecture 

 XML Schema Type                     Java Data Type 

 xsd:string    java.lang.String 

 xsd:integer    java.math.BigInteger 

 xsd:int    int 

 xsd.long    long 

 xsd:short    short 

 xsd:decimal    java.math.BigDecimal 

 xsd:float    float 

 



JAXB vs. DOM and SAX 

• JAXB is not part of the standard Java distribution, but is available from Sun 
as part of the Java Web Services Developer Pack (Java WSDP) 

 

• JAXB is a higher level construct than DOM or SAX 

– DOM represents XML documents as generic trees 

– SAX represents XML documents as generic event streams 

– JAXB represents XML documents as Java classes with properties that 
are specific to the particular XML document 

• E.g. book.xml becomes Book.java with getTitle, setTitle, etc. 

 

• JAXB thus requires almost no knowledge of XML to be able to 
programmatically process XML documents! 



Is JAXB enough? 

• Marshall and unmarshall the XML file 



TodoMap class 

 



JAXB marshall and unmarshall 

 



TodoResource Class > Marshall or 
Unmarshall? 

 



TODOResource 

 



TODOResource 

 



TODOResource 

 



TODOResource > addTodo 

 



TODOResource > addTodo 

 



First run 

 



Directory & File Creation 

 



Add a Todo 

 



Add a Todo > XML is updated 

 



Add a Todo > XML is updated 

 



Delete a Todo 

 



Delete a Todo 

 



Delete a Todo > Updated XML file 

 



Τέλος Ενότητας



Χρηματοδότηση
•Το παρόν εκπαιδευτικό υλικό έχει αναπτυχθεί στα πλαίσια του εκπαιδευτικού 
έργου του διδάσκοντα.

•Το έργο «Ανοικτά Ακαδημαϊκά Μαθήματα στο Πανεπιστήμιο Κρήτης» έχει 
χρηματοδοτήσει μόνο τη αναδιαμόρφωση του εκπαιδευτικού υλικού.

•Το έργο υλοποιείται στο πλαίσιο του Επιχειρησιακού Προγράμματος 
«Εκπαίδευση και Δια Βίου Μάθηση» και συγχρηματοδοτείται από την 
Ευρωπαϊκή Ένωση (Ευρωπαϊκό Κοινωνικό Ταμείο) και από εθνικούς πόρους.



Σημειώματα



Σημείωμα αδειοδότησης
• Το παρόν υλικό διατίθεται με τους όρους της άδειας χρήσης Creative Commons 

Αναφορά Δημιουργού - Μη Εμπορική Χρήση - Παρόμοια Διανομή 4.0 [1] ή 
μεταγενέστερη, Διεθνής Έκδοση.   Εξαιρούνται τα αυτοτελή έργα τρίτων π.χ. 
φωτογραφίες, διαγράμματα κ.λ.π.,  τα οποία εμπεριέχονται σε αυτό και τα οποία 
αναφέρονται μαζί με τους όρους χρήσης τους στο «Σημείωμα Χρήσης Έργων Τρίτων».

[1] http://creativecommons.org/licenses/by-nc-nd/4.0/

•Ως Μη Εμπορική ορίζεται η χρήση:
–που δεν περιλαμβάνει άμεσο ή έμμεσο οικονομικό όφελος από την χρήση του έργου, για το διανομέα του 
έργου και αδειοδόχο
–που δεν περιλαμβάνει οικονομική συναλλαγή ως προϋπόθεση για τη χρήση ή πρόσβαση στο έργο
–που δεν προσπορίζει στο διανομέα του έργου και αδειοδόχο έμμεσο οικονομικό όφελος (π.χ. διαφημίσεις) 
από την προβολή του έργου σε διαδικτυακό τόπο

•Ο δικαιούχος μπορεί να παρέχει στον αδειοδόχο ξεχωριστή άδεια να χρησιμοποιεί το 
έργο για εμπορική χρήση, εφόσον αυτό του ζητηθεί.
.
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